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New and updated feature summary 
 
This section lists the new and updated features that are available in ADINA System 9.0, as 
compared with ADINA System 8.9.4. (For features and improvements added between 9.0 and 
9.0.7, see the section "Improvements between 9.0.0 and 9.0.7" below.) 
 
There are new commands and new and changed parameters associated with the new and 
updated features. The release notes refer to the commands and parameters in the command-
line formats.  Further information about the new commands and new and changed parameters 
can be found in the AUI Command Reference Manuals. 
 
For user interface users, most command-line parameters have analogous fields in the dialog 
boxes. 
 
Note, when we refer to documentation, we refer to the versions of the documentation given 
below in the “Available Documentation” section. 
 

Features for all programs 
 
Table of supported program versions 
 

Platform Operating system Version ADINA-M Parallelized 
assembly1 

Fortran 
compiler 

Linux 
x86_64 / 
Opteron  

2.6.18 and higher, 
glibc 2.5 and higher 

64-bit Parasolid 
and Open 
Cascade 

Yes Intel ifort 11.1 

PC x86 Windows XP, Vista, 
7 

32-bit2 Parasolid 
and Open 
Cascade 

No Compaq 
Visual Fortran 
6.6 

PC 
x86_64 / 
Opteron 

Windows XP, Vista, 
7, 8 

64-bit Parasolid 
and Open 
Cascade 

Yes Intel Visual 
Fortran 11 

 
1) All program versions have parallelized solvers. Only ADINA and ADINA-Thermal have 
parallelized assembly. 
 
2) The 3GB address space option is supported. 
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ADINA Solids & Structures features 
 
Noh-Bathe method for explicit time integration 
 
The Noh-Bathe method is a second order accurate explicit time integration scheme, which can 
be used with or without stiffness and mass based Rayleigh damping.  
 
There are three areas in which the Noh-Bathe method is superior to the central difference 
method:  
 
  Wave propagation problems 
  Damping, especially if Rayleigh damping is used 
  When accelerations are important. 
 
For details, see the ADINA Theory and Modeling Guide, Section 8.1.2. 
 
¾ Command-line:  

ANALYSIS DYNAMIC-DIRECT-INTEGRATION ... METHOD=NOH-BATHE   
GAMAP 

 
Component mode synthesis 
 
Component mode synthesis analysis can be performed to output the frequencies/mode shapes 
of the reduced model for the AVL Excite interface or to continue with additional subspace 
iterations for a more accuracy frequency solution. See the description in Section 11.18 of the 
ADINA Theory and Modeling Guide for more details.  
 
¾ Command-line:  

FREQUENCIES ... METHOD=CMS  AVL-OUT  CMS-SUBSPACE 
 
Improvements to 2D elements 
 
2D elements can now be defined in the X-Y, Y-Z or X-Z planes, only for certain commonly-
used analysis options. This feature is added for compatibility with Nastran.  For axisymmetric 
elements, the axis of symmetry can be either of the planar coordinate axes (i.e., for 2D 
elements in the X-Y plane, the axis of symmetry can be either the X axis or the Y axis).  
 
The default is that 2D elements are defined in the Y-Z plane, and the axis of symmetry of 
axisymmetric elements is the Z axis (the same as in previous versions of ADINA.) 
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Exceptions, for which the 2D elements must be defined in the Y-Z plane with axis of 
symmetry given by the Z axis, are 
 

 Potential-based fluid elements  
 Cohesive elements 
 2D FSI problems (the 2D elements of ADINA-CFD must be defined in the Y-Z plane 

with axis of symmetry given by the Z axis)  
 Cyclic symmetry 
 Piezoelectric material model 
 Fracture mechanics 

 
¾ Command-line:  

MASTER  2DPL-AX 
 
Piezoelectric effects 
 
A new piezoelectric feature with direct coupling formulation is implemented in version 9.0. A 
piezoelectric material model, as a new material type, is added and is applicable for both 2D 
and 3D solid elements. Section 3.16 of the ADINA Theory and Modeling Guide describes the 
new piezoelectric formulation.  
 
The new piezoelectric feature is separate from the piezoelectric option with user-supplied 
material and iterative procedure, that was previously available in ADINA Thermal. 
 
As a new DOF type, Voltage is added through the piezoelectric analysis and as a DOF option 
for constraint equations and boundary conditions. Correspondingly, three new load types: 
Voltage, distributed charge (DCHARGE) and concentrated charge (CCHARGE) are added.  
 
¾ Command-line:  

MATERIAL PIEZOELECTRIC  
LOAD VOLTAGE 
LOAD CCHARGE 
LOAD DCHARGE 
EGROUP TWODSOLID ... OPTION=PIEZOELECTRIC 
EGROUP THREEDSOLID ... OPTION=PIEZOELECTRIC 
APPLY-LOAD 
   ... ltypei=(VOLTAGE/CCHARGE/DCHARGE) 
FIXITY 
   ... dofi=VOLTAGE 
CONSTRAINT ... SLAVEDOF=VOLTAGE 
   ... masterdofi=VOLTAGE 
CONSTRAINT-MS ... MASTERDOF=VOLTAGE 
   ... slavedofi=VOLTAGE 
CONSTRAINT-NODE ... SLAVEDOF=VOLTAGE 
   ... masterdofi=VOLTAGE, ... slavedofi=VOLTAGE 
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Improvements to Hermitian beam element 
 
The Hermitian beam element is reformulated in version 9.0. Many restrictions regarding the 
various cross-sections and use of the warping beam are removed. Section 2.4 of the ADINA 
Theory and Modeling Guide has been rewritten.  
 
In particular, note that the use of the command KINEMATICS BEAM-ALG=V87 is no longer 
necessary, and is not recommended. The only reason to use this command is for backwards 
compatibility with previous versions of ADINA.  
 
In the following, we give a few highlights of the Hermitian beam element in version 9.0. 
 
There are two element interpolations: the standard beam element (element without warping 
degrees of freedom) and the warping beam element (element with additional warping degrees 
of freedom).  
 
All cross-sections, except for the general cross-section, can be used under the following 
conditions: 
 
  Linear elastic 
  Large displacement elastic 
  MNO plastic 
  Large displacement plastic 
 
The general cross-section can be used under linear or large displacement elastic conditions.  
 
The general cross-section can be used with a non-zero product of inertia for both the standard 
and warping beams. The Wagner effect cross-section geometric properties for the general 
cross-section are changed, and a new Wagner effect property is added. 
 
The general cross-section and thin-walled cross-sections (box, I, U, L) can include the 
Wagner effect under large displacement conditions (elastic or plastic). These sections can be 
used either with the standard beam element or with the warping beam element. However, it is 
not recommended that thin-walled open cross-sections (I, U, L) be used with the standard 
beam element in general (see Section 2.4.4.3 of the ADINA Theory and Modeling Guide for 
details, and also for special cases in which the thin-walled open cross-sections can be used 
with the standard beam element.) 
 
The cross-sectional axes of the L cross-section are aligned with the legs of the cross-section, 
for both the standard and warping beams, thus the product of inertia of the L cross-section is 
non-zero for both the standard and warping beams. 
 
The thin-walled cross-sections include additional parameters to control the assumptions used 
in the formulation. In particular, the additional parameters can be used to recover the 
assumptions used in version 8.9. 
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Section forces and moments can be computed in both the elastic and plastic beam elements, 
for static and dynamic analysis. These section forces and moments are not the same as the 
nodal point forces and moments, when the shear center does not coincide with the cross-
section centroid (see Section 2.4.5.7 of the ADINA Theory and Modeling Guide for details.) 
 
¾ Command-line:  

CROSS-SECTION GENERAL ... RRINERTIA 
CROSS-SECTION BOX ... ASSUMPTIONS  WAGNER  TORFORMULA 
CROSS-SECTION I ... ASSUMPTIONS  WAGNER  TORFORMULA   

STANDARD 
CROSS-SECTION U ... ASSUMPTIONS  WAGNER  TORFORMULA   

STANDARD 
CROSS-SECTION L ... ASSUMPTIONS  WAGNER  TORFORMULA   

STANDARD 
 
Improvements to shell element 
 
The concrete material model can be used in conjunction with the multilayered shell element.  
 
Improvements to contact 
 
Contact search for 3D explicit contact 
 
An improved fast contact search is available for 3D explicit contact problems. The default is 
to use the contact search of version 8.9. 
 
¾ Command-line:  

CONTACT-CONTROL ... 3D-SEARCH 
 
Improved contact tractions 
 
The contact tractions output for new contact surfaces are improved, see the discussion at the 
end of Section 4.4 in the ADINA Theory and Modeling Guide,  
 
¾ Command-line:  

CONTACT-CONTROL ... TRACT-CALC  TRACT-ANGLE   
TRACT-QUADRATRIC 

 
Contact pressure control of prescribed loads 
 
The feature of contact pressure control of prescribed loads is improved, see Section 5.3.6 of 
the ADINA Theory and Modeling Guide. 
 
¾ Command-line:  

CONTACT-CONTROL ...PRESSURE-CONTROL 
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Group-based mass-proportional loading 
 
Mass-proportional loading can be separately applied to individual element groups. 
 
Improvements to ADINA-TMC heat flow solutions 
 
Convection, radiation and heat flux loads can now be applied on constrained DOFs.  2-D heat 
flow problems can now be placed (in addition to the default yz plane) in the xy or xz planes. 
 

ADINA Thermal & TMC features 
 
Joule-heat analysis 
 
The 1D and shell conduction elements can be used in Joule-heat analysis, see Chapter 12 of 
the ADINA-T Theory and Modeling Guide.  
 
Improvements in load calculations 
 
As compared to version 8.9, I/O is reduced and the solution times are improved, particularly 
when the number of time functions is large. 

 
ADINA CFD & FSI features 
 
New Distributed Memory Processing (DMP) feature 
 
This feature adds full capability of Distributed Memory Parallel (DMP) computing to FCBI-C 
elements with AMG solvers in ADINA-F and ADINA-FSI, with the exceptions of restart 
analysis, adaptive meshing, porous and thermal coupling with structure. 
 
With this option, the fluid domain is automatically divided into sub-domains that are loaded 
onto each MPI process. The overall solution is obtained by the AMG iterative solver, with 
computation loads shared by all processes. This feature makes our FCBI-C elements highly 
efficient, achieving nearly linear reduction in both CPU and memory usage, and makes it 
possible to solve much larger CFD and FSI problems than we could in the past. 
 
The whole procedure of using this feature is the same as in previous DMP releases.  
 
Cavitation models 
 
Two cavitation models (ZGB and KUNZ) are available for cavitating flow simulations with 
the FCBI-C element. These two models are added into the VOF equation for incompressible 
flows without non-condensable gases.  
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¾ Command-line:  
MASTER …VOF=CAVITATION 
VOF-MATERIAL … NCAV  CAV-MODEL  CDEST  CPROD  PVAP, 

    UINF  TINF  VOFNUC  RBUBBLE 
 
Improvements to SAM (steered adaptive meshing) 
 
Prismatic meshes obtained with the BODY SWEEP or BODY REVOLVE commands can 
now be used with SAM. 
 
Improvements to leader-follower option 
 
The  default type of leader-follower is called parallel.  As an additional option, a type called 
closest can also be used.  In this case, the follower is, while always constrained on the 
boundary where it stays, the closest point to the leader.  This type of leader-follower option is 
useful when associated with the gap boundary condition.  Note that there might be multiple 
closest points.  In this case, the program will pick up one randomly as the follower’s location 
point.  If this result is not expected, avoid using this type.  
 
¾ Command-line:  

LEADER-FOLLOWER ... TYPE 
 

AUI features 
 

User interface improvements 
 
New icons 
 
For the 64-bit Windows version, a new toolbar is available for use with the fast graphics 
mode. The icons are only active if the fast graphics mode is supported on the machine. 
 
Tree view 
 
Icon images are added to the tree view display. Zones can be modified and deleted through the 
right-click menu on the tree view. In addition, multiple zones can be selected for display, 
highlighting or deletion. 
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Model definition 
 
Import of ANSYS files 
 
AUI 9.0 can import element face-sets in ANSYS formats. 
 
¾ Command-line:  

IMPORT EXTERNAL-FORMAT=ANSYS 
 
Improvements to ADINA-M 
 
It is allowed to add offsets to a solid geometry body.  This feature is applicable for Parasolid-
based geometry modeling, but not for Open Cascade-based geometry modeling. 
 
¾ Command-line:  

BODY OFFSET 
 
Rigid links 
 
The fixities generated for elements connected to rigid links are improved. In particular fixities 
are no longer generated for the rotational degrees of freedom when rigid links are connected to 
continuum elements. If it is necessary to override this behavior, use the command ADINA 
FIXBOUNDARY=V89 (not the default). 
 
Large models 
 
The efficiency of the AUI in generating large models is significantly improved. 
 
Model display and post-processing 
 
Zone definition using the mouse, OpenGL 
 
The graphics associated with the use of the mouse for creating zones have been improved, 
when the OpenGL graphics system is used. One consequence of this improvement is that the 
"antialiasing" feature of many graphics cards needs to be deactivated in order for the zone 
creating feature to work properly.  The AUI attempts to deactivate antialiasing, but certain 
graphics cards can override this setting. For example, for NVIDIA graphics cards, there is a 
setting in the NVIDIA control panel: Antialiasing Mode, and when this setting is set to 
"Override the Application Setting", the antialiasing feature will be used. So we recommend 
that Antialiasing Mode not be set to "Override the Application Setting". 
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Fast graphics mode 
 
The Windows 64-bit version of the AUI includes a new visualization option, called the fast 
graphics mode (FGM). This option is available when the graphics card supports Open GL 3.3 
or higher. FGM improves the visualization of large models when used with professional-class 
graphics cards. 
 
The fast graphics mode is described in the section "Fast Graphics Mode" below, 
 

Improvements between 9.0.0 and 9.0.7 
 
ADINA Solids & Structures improvements 
 
Incompatible modes elements 
 
Recently we have found that geometrically nonlinear incompatible modes elements with large 
aspect ratio can give rise to spurious modes in the solution.  Therefore we have changed the 
default for the use of incompatible modes. In 9.0.1 and earlier, the default was to use 
incompatible modes for static and implicit analysis. However, in 9.0.2 and higher, the default 
is not to use incompatible modes.  
 
Because of this change of default, the same AUI input may give different results in 9.0.1 and 
9.0.2. 
 
With this change of default, in the command-line input, the command KINEMATICS 
INCOMPATIBLE-MODES=AUTOMATIC is the same as KINEMATICS 
INCOMPATIBLE-MODES=NO. 
 
In order to use incompatible modes, use the command KINEMATICS INCOMPATIBLE-
MODES=YES. 
 
¾ Command-line:  

KINEMATICS  INCOMPATIBLE-MODES 
 
Improvements to explicit contact 
 
In versions 9.0.2 and higher, the default contact algorithm for explicit contact depends on the 
time integration method used: 
 

Central difference method: use kinematic constraint method  
Noh-Bathe method: use penalty method. 
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¾ Command-line:  
CONTACT-CONTROL XCONT-ALGORITHM=DEFAULT 

 
Improvements to low-speed dynamics option 
 
In versions 9.0.2 and higher, either the Newmark method or the Bathe method can be used in 
low-speed dynamics. The default is to use the Newmark method. 
 
¾ Command-line:  

AUTOMATIC  TIME-STEPPING  METHOD 
 
Gap-conductance 
 
In versions 9.0.2 and higher, the gap-conductance feature can be used to model heat transfer 
between closely-adjacent contact surfaces.  See the Gap-conductance Feature section in this 
document for more details. 
 
¾ Command-line:  

GAP-CONDUCTANCE 
 
Saving heat conductivity and heat capacity matrices onto disk files 
 
In versions 9.0.2 and higher, the heat conductivity and heat capacity matrices can be output to 
the .mtx file for all TMC solution options i.e. heat only, one-way coupling, iterative coupling 
and direct coupling. Heat conductivity/heat capacity matrices can be saved with or without 
stiffness and mass matrices in the *.mtx file. Command DISK-STORAGE has been modified 
to include heat conductivity and heat capacity matrices. 
 
The heat flow matrices are saved in the equation format only, even if a node-based format is 
requested using the DISK-STORAGE  GLOBAL-M parameter. 
. 
¾ Command-line:  

DISK-STORAGE  NSTEP-HEAT  CONDUCT-MATRIX  HEATCAP-MATRIX 
 
Total solution time printout 
 
In versions 9.0.2 and higher, the total solution time is printed after every solution step in 
nonlinear static and implicit dynamic analysis. 
 
User-coded materials and porous media 
 
In versions 9.0.3 and higher, user-coded material models can be used with porous media. 
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Saving stiffness and mass/damping matrices onto disk files 
 

In versions 9.0.3 and higher, the option GLOBAL-MATRIX=FULL is added to the DISK-
STORAGE command, which is used to write matrices on the *.mtx disk file:  

 
A non-factorized, linear or nonlinear, global stiffness matrix can be saved using a disk file 
(*.mtx file), for a given time step. For implicit dynamic solutions a mass matrix (lumped or 
consistent) and Rayleigh damping matrix can also be stored on the same *.mtx file if 
requested. There are three available options:  

 
GLOBAL-MATRIX=FULL   
Matrices are given in full upper triangular by column heights form. The program will then 
write stiffness, mass and damping matrices for the last solution time only. The *.mtx file will 
contain the following data:  
 

MAXA array for full by column heights stiffness/mass/damping matrices 
 

Full by column heights stiffness matrix followed by mass and damping matrices (if 
required)  

 
GLOBAL-MATRIX=SAVE 
The matrices are given in a “sparse” form, i.e. zero matrix elements in the columns are 
removed and can be written to the *.mtx file for any time step. The *.mtx file always contains 
the following data: 
 

MAXA array, column heights vector with the zero elements in the columns removed (from 
the matrix diagonal for symmetric matrices, from the matrix bottom for non-symmetric 
matrices)  

 
Equation numbers for the nonzero matrix elements 

 
Stiffness matrix followed by mass and damping matrices (if requested) according to the 
MAXA array used here.  

 
GLOBAL-MATRIX=NODE 
The matrices (i.e. stiffness, mass and damping) are given in a sparse form and can be written 
out to the *.mtx file for any solution time step. The matrices are written for every node in a 
“direct matrix input” format required by AUI. The matrices can then be used in other models 
as input data for the direct matrix input options.   
 
¾ Command-line:  

DISK-STORAGE  GLOBAL-MATRIX  STIFFNESS-MATRIX, 
      MASS-MATRIX  DAMPING-MATRIX 
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Improvements to Hermitian beam elements 
Considering Hermitian beam elements with cross-sections in which the product of inertia is 
nonzero, these elements can now be used with shear correction factors in versions 9.0.6 and 
higher.   
 
Frequency analysis with frictional contact 
In versions 9.0.6 and lower, a contactor node is tangentially glued to the target whenever the 
contact force at that contactor node exceeds RCONSM.  This tangential gluing is applied both 
when the contactor node is "sticking" and also when the contactor node is "sliding". 
 
In versions 9.0.7 and higher, a contactor node is tangentially glued to the target whenever the 
status of the contactor node is "sticking".  The magnitude of the contact force is not used to 
determine whether a contactor node is tangentially glued to the target. 
 
Notice that if the status of the contactor node is "sliding", the contactor node is tangentially 
unconstrained during the frequency analysis, in other words, the contactor node is free to slide 
along the target when the status of the contactor node is "sliding". 
 
As a consequence of this improvement, models in which there are a significant number of 
nodes in sliding contact at the time of the frequency analysis will give different results.  If the 
physics of the problem require the nodes to be sticking during the frequency analysis, follow 
this procedure.  After the last static solution step, add an extra static solution step, in which no 
additional loads are applied, but with very large time step. After this extra static step, the 
nodes should be sticking.  
 

ADINA CFD & FSI improvements 
 
The default parameter values in the following commands have been changed in versions 9.0.1 
and higher. 
 
(1)  OUTER-ITERATION  …  MS-SOLVER 
 
This command only affects FCBI-C elements in solving moving-mesh problems.   
 
The default parameter value of MS-SOLVER in version 9.0 is “DEFAULT”, which is 
equivalent to “FD-SOLVER”.  This indicates that the moving mesh solver is the same as the 
fluid solver, in which the displacement degree of freedom is defined at the element center and 
the nodal displacement is interpolated.  This is a natural choice if memory is not enough for 
sparse solver. 
 
The default parameter value in version 9.0.1 has been changed to “SPARSE”, indicating that 
the sparse solver is used for solving for the nodal displacements. This is a natural choice if 
memory is not an issue.  
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(2)  MASTER  …  MESHUPDATE 
 
This command affects moving-mesh problems.   
 
The default parameter value of MESHUPDATE in version 9.0 is “CURRENT”, indicating 
that the current mesh at each time step is used as the background mesh for solving for the 
displacements. 
 
The default selection in version 9.0.1 has been changed to “ORIGINAL”, indicating that the 
original mesh is used as the background mesh for solving for the displacements. 
 
When FCBI-C elements are used for moving mesh problems, the choices MS-SOLVER= 
SPARSE together with MESHUPDATE=ORIGINAL are the most efficient, as long as there is 
enough memory.   
 

AUI improvements 
 
Improvements to edge and face commands in 9.0.1 
 
In versions 9.0.1 and higher, the following commands can now be used on multiple bodies in a 
single command execution. This improvement is especially effective in the user interface, 
since now the user can select edges or faces on different bodies in a single operation. 
 
¾ Command-line:  

ELDELETE EDGE, bodyi 
ELDELETE FACE, bodyi 
SUBDIVIDE EDGE, bodyi 
SUBDIVIDE FACE, bodyi 
GEDGE, bodyi 

 
Mapped meshing option for face meshing 
 
In versions 9.0.2 and higher, geometry faces can be meshed using mapped meshing, for those 
faces with four-sided faces with equal number of subdivisions on opposite faces. The 
following options are available: 
 
 Free-form meshing (the default): All faces are meshed using free-form meshing 
 
 Mapped: All four-sided faces with equal number of subdivisions on opposite faces are 
meshed using mapped meshing, and other faces are ignored. 
 
 Mixed: All four-sided faces with equal number of subdivisions on opposite faces are 
meshed using mapped meshing, and other faces are meshed using free-form meshing. 
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¾ Command-line:  
GFACE  MESHING  PATTERN 

 
Improvements to potential-interfaces 
 
In 9.0.2 and higher, potential-interfaces can be applied using element edge-sets or element 
face-sets. 
 
¾ Command-line:  

POTENTIAL-INTERFACE  GTYPE 
 
Merging option to keep shared geometry 
 
In 9.0.2 and higher, there is a merging option to merge all the mergeable imprinted edges 
created by command BODY MERGE. The default is to merge the mergeable imprinted edges. 
¾ Command-line:  

BODY-MERGE  MERGE-IMPRINT 
 
Node snap option 
 
In 9.0.4 and higher, there is a new command that moves (snaps) a node to a point. The user 
specifies the point (or points), and the element group number. The node in the element group 
closest to the point is moved. This node is then associated with the point, such that any load, 
BC, spring element, etc. on the point is applied to the node. 
 
¾ Command-line:  

NODE-SNAP 
 
 

Gap-conductance feature 
 
With the gap-conductance feature, introduced in version 9.0.2, heat transfer between closely 
adjacent contacting surfaces can be modeled. 
 
• Conductive heat transfer between closely adjacent (or contacting) surfaces is governed by 

an equation similar to that used for convection boundary conditions. The heat flux 
entering contact surface I  is 

 

( )ˆI J I
cq hω θ θ= −  (1) 

 
where ω  is the gap conductance, 0 1ω≤ ≤ , ĥ  is the contact heat transfer coefficient, 
and Iθ  and Jθ  are the temperatures of the contacting surfaces. 
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• Note that in the limit as ĥ  approaches infinity, the temperatures of the contacting surfaces 

become equal to each other. With ĥ  large, Eq. (1) can be considered to be a penalty 
method approximation to the equation I Jθ θ= . 

• The gap conductance ω  controls the amount of heat transfer. It can be used to simulate 
conductive (and convective) heat transfer that might occur in the clearance gap before 
contact. In addition, gap conductance can significantly improve the convergence rate as it 
smoothes the discontinuity in heat conductance at initial contact. 

• The following gap conductance options are available: 

Gap Distance Option: The gap conductance ω  is a function of the clearance gap, 
g , only. 

Contact Pressure Option: The gap conductance ω  is a function of the contact 
pressure, p , only. 

Gap and Pressure Option: The gap conductance ω  is a function of the clearance 
gap, g , before contact is established, and is a function of the contact pressure, p , 
after initial contact. 

Time Function Option: The gap conductance ω  is governed by a time function 
starting with an initial contact. 

(a) Gap and pressure option (linear) (b) Gap and pressure option (quadratic)

(c) Time function option

Figure 1: Options used to define the gap conductance, �
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• In the gap and pressure option, the critical clearance gap and critical contact pressure, 1g  

and 1p , respectively, must be defined. There is no heat conductance between the 

surfaces when 1g g≥ , and there is full heat conductance when 1p p≥ ; see Fig. 1(a). 

Also, the fraction of conductance, 0ω , at initial contact (i.e. when 0g =  and 0p = ) 
must defined. Hence, 

 

1g g≥ ; 0I
cq =  

0g =  and 0p = ; ( )0
ˆI J I

cq hω θ θ= −  

1p p≥ ; ( )ˆI J I
cq h θ θ= −  

For this option, the conductance can vary linearly or quadratically as shown in Fig. 1(a) 
and 1(b), where the quadratic variation might improve the convergence rate. 

 
• In the time function option, the time function, ( )f t , specifies the gap conductance after 

initial contact. Arrival times are automatically set for every contact node once the node is 
in a contact state. If the node status becomes out-of-contact, then the time function is set 
to zero. If the node becomes again in contact, then a new arrival time is set for the time 
function. 

 
The gap conductance time function must cover the full solution time. 

 
• Typically, the contact pressure option results in the best convergence rate as the correct target 

segment is always selected in this case. The smallest critical contact pressure 1p  that results 
in good convergence should be used. This option often removes the chattering in the contact 
iterations that would otherwise result from the sudden application of heat conductivity. With 
the gap distance option, the incorrect target segment can be selected if the critical clearance 

1g  is too large. 

• The gap conductance is defined using the GAP-CONDUCTANCE command (new 
command). The default gap conductance for a contact group can be specified using the 
GAPC-NAME parameter of the CGROUP command (new parameter), and the gap 
conductance for individual contact pairs can also be specified using the GAPC-NAME 
parameter of the CONTACTPAIR command. 
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Fast Graphics Mode 
 
Introduction 
 
The Windows 64-bit version of the AUI includes a new visualization option, called the fast 
graphics mode (FGM). 
 
The FGM graphics take advantage of the powerful graphics cards, and this results in 
extremely fast graphics rendering and manipulation. In addition, the user interactions with the 
FGM are intuitive and natural. 
 
The FGM has a wide variety of options that permit sophisticated effects to be applied to the 
model visualization. These options are described in more detail below. 
 
The graphical display of version 8.9 and earlier is also available, and is unchanged in version 
9.0. In this section, the graphical display of version 8.9 and earlier is called the standard mode. 
 
There are certain features of the standard mode that are not available in FGM, including 
• Multiple mesh plots 
• Vector snapshot option 
• Movie shoots and animations 
 
Hardware requirements 
 
The ADINA 9.0 Fast Graphics Mode (FGM) requires a medium range graphic card. 

 
The minimum requirements are: 
 
• OpenGL 3.3 compatible graphic card. 
• 1GB on board video memory. 
• Windows 64-bit operating system, Vista or later.  
 
The following graphics cards have been tested: 
 
• NVIDIA Quadro NVS 295 
• NVIDIA Quadro 410 
• NVIDIA Quadro 600 
• AMD FirePro V4900 
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(note, Intel graphics cards are not compatible with FGM). 
 
We highly recommend that you update your graphics card drivers from AMD or NVIDIA for 
best performance. 
 
Activating FGM 
 
To run FGM, the current Graphics System must be OpenGL (use Edit→Graphics System to 
choose OpenGL). 
 
When the FGM is available, the Fast Graphics icon  is ungrayed.  Clicking this icon 
enables the FGM.  To disable FGM and return to the standard mode, click the Fast Graphics 
icon  again. 
 
It is important to remember that graphical changes made in the standard mode do not affect 
graphical changes made in FGM, and vice versa. 
 
FGM settings 
 
Projections 
 
The FGM can use either an orthographic (parallel) or a perspective projection for display. 

 
Left orthographic projection, right perspective projection 
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To choose the projection: 
• Right-click in the graphics window, then choose View→Parallel or View→Perspective. 
 
Parallel 
In Parallel mode, the model is displayed so all its points project along parallel lines to their 
positions on the screen. In Parallel mode, 3D models appear flat and unreal. 
 
Perspective 
In Perspective mode, the model is displayed in a more natural fashion. Objects further away 
from the camera appear smaller than closer objects. One important difference with Parallel 
mode is that the part of the model that lies behind the camera is not visible in Perspective 
mode. 
 
Axes 
In the FGM the standard axes have been replaced by axes drawn in a more modern style. The 
new axes are situated at the left bottom of the graphics window. 

 
To toggle the visualization of the axes: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport tab. 
3. In the Viewport box, check/uncheck the Show Axes option. 

 
Scene Bounding Box (BBox) 
The Scene BBox option draws a box around the whole model. This box is useful to show the 
limits of the model. The Scene BBox is used by a number of features to let the user activate or 
define a working plane. 
 
To toggle the visualization of the Scene BBox: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport tab. 
3. In the Viewport box, check/uncheck the Scene BBox option. 
 
Background 
The background used in FGM can be customized. 
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To customize the background: 
1. Right-click in the graphics window and choose Background. 
2. Choose the type of background (see below) 
 
Solid  
Works in the same way as the background in the standard mode. Select the background color 
using the Top field.  
 
Ramp 
Creates a vertical gradation between the Top color and the Bottom color 

 
File 
Allows an existing image file to be used. Use the File field to choose the image file. The 
image file must be in the .tga file format. 

 
Navigation tools 

 
One of the new features in FGM is the Standard Navigation Interface (SNI). The SNI permits 
the user to interact with the scene in a more intuitive way. It is possible to use the standard 
interface but some new features will be not available. 
 
To activate/deactivate the standard interface for the FGM: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced tab. 
3. Check/uncheck the Use Classical UI field. 
 
Standard navigation interface 
 
The SNI has been optimized for fast response, due to this, the display quality will be affected 
during navigation. 

 
All the navigation operations applied inside the FGM view are unique for the FGM view and 
will not modify the current view configuration in the standard mode. Because this, navigation 
operations do not support the standard Undo/Redo command. 
 
Hot Navigation Tool (HNT) 
As will be clarified below, the SNI uses Hot Navigation Tool buttons in order to activate the 
interface tools. The advantage of using the HNT buttons is that the view can be manipulated at 
any time without leaving the current tool/mode. 
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The HNT buttons are: 
 F2 - Zoom View Tool 
 F3 - Pan View Tool 
 F4 - Orbit View Tool 
 I - Zoom Region Tool 
 J - Unzoom All Oneshot 
 Q - Zoom Selection Oneshot 
 
Orbit View Tool 
 
The Orbit View Tool rotates the current view on a fixed pivot point. 

 
To activate the Orbit View Tool: 
• Click the Dynamic Rotate (XY) icon or press and hold the F4 key (HNT). 
 
After the Orbit View Tool is activated, the Navigation Trackball is displayed on the screen. 
The mouse cursor will change to show the function of the action available for the trackball 
area where the cursor is. The trackball interface is divided into four action zones: 
 
a) Inside the circle, any drag action over this zone will act like the standard Dynamic Rotate 

(XY) icon. 
b) Outside the circle, the drag actions over this zone will act like the standard Dynamic 

Rotate (Z) icon. 
c) On vertical lines, the rotation will be limited to the Y axis of the screen only. 
d) On horizontal lines, the rotation will be limited to the X axis of the screen only. 

 
To rotate the view: 
1. Select the desired rotation type by positioning the cursor over one of the four action 

zones. 
2. Press the left mouse button and while it is pressed, drag the cursor in the desired direction 

of rotation. 
3. Release the left mouse button. 

 
The rotation uses the Navigation Pivot Point (NPP) as the center of rotation, see below. 
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It is possible to rotate the model about the model X, Y and Z axes by holding down the left 
Ctrl key while dragging the trackball. 
a) Click on a vertical line to rotate about the model X axis 
b) Click on the circle to rotate about the model Y axis. 
c) Click on a horizontal line to rotate about the model Z axis 

 
To cancel the current rotation action, right-click without releasing the left mouse button. 
  
The rotation increment can be adjusted using the Angle Snap Mode (see below). 

 
To exit the Orbit tool when using the F4 key, release the F4 key. 
To exit the Orbit tool when using the Dynamic Rotation (XY) icon: 
• Press the Escape key, or  
• Single click on the screen, or, 
• Click an icon such as the Pick, Pan, Dynamic Rotate (Z) or Dynamic Resize icons. 

 
The Orbit Tool supports Double Click and Go (see below). 
 
Camera Spin Mode 
While in this mode, the camera will rotate around the model with the latest rotation magnitude 
applied to the camera. 

 
To activate Camera Spin Mode, release the left mouse button while dragging the mouse. 

 
To exit Camera Spin Mode, 
• Press the left mouse button, or 
• Exit the Orbit View Tool 

 
Pan View Tool 
The Pan View tool pans the view in the XY plane of the screen. 
 
To pan the view: 
1. Click the Dynamic Pan icon or press and hold the F3 key (HNT). 
2. Press the left mouse button and while it is pressed, drag the cursor in the desired 

direction. 
3. Release the left mouse button. 

 
It is possible to cancel the current Pan action by right-clicking without release the left mouse 
button. 
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The displacement factor is proportional to the distance of the camera from the Navigation 
Pivot Point (NPP).  

 
Moving the view using the Pan View tool changes the current NPP. 
 
If the distance of the camera from the NPP is too small, the Pan View Tool might not work 
correctly, in this case click the Unzoom All icon to restore the view. 

 
To exit the Pan View Tool when using the F3 key, release the F3 key. 

 
To exit the Pan View Tool when using the Dynamic Pan icon: 
• Press the Esc key, or, 
• Single click on the screen, or 
• Click an icon such as the Pick, Dynamic Rotate (XY), Dyamic Rotate (Z) or Dynamic 

Resize icons. 
 
Zoom View Tool 
 
The Zoom View tool zooms into and out of the view. The behavior is similar to the standard 
Dynamic Resize.  
 
To zoom the view: 
1. Click the Dynamic Resize icon or press and hold the F2 key (HNT). 
2. Press the left mouse button and while it is pressed, drag the cursor up and down until the 

desired zoom level is reached. 
3. Release the left mouse button. 

 
It is also possible to zoom by using the mouse wheel. 
 
The zoom factor is proportional to the distance of the camera from the NPP.  
 
If the distance of the camera from the NPP is too small, the Zoom View Tool might not work 
correctly, in this case click the Unzoom All icon to restore the view. 

 
It is possible to cancel the current zoom action by right-clicking without releasing the left 
mouse button (however not when zooming using the mouse wheel). 
To exit the Zoom View Tool when using the F2 key, release the F2 key. 
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To exit the Zoom View Tool when using the Dynamic Resize icon: 
• Press the Esc key, or 
• Single click on the screen, or 
• Click an icon such as the Pick, Dynamic Rotate (XY), Dyamic Rotate (Z) or Pan icons. 
 
Zoom Region Tool 
The Zoom Region tool zooms into a region of the screen. The behavior is similar to the 
standard Zoom icon. 
 
To zoom into a region of the screen: 
1. Click the Zoom icon or press and release the I key. 
2. Left-click and drag the Zoom region rectangle as desired. 
3. Release the left mouse button. 
 
To exit the Zoom View tool:  
• Press the Esc key, or 
• Click an icon such as the Pick, Dynamic Rotate (XY), Dyamic Rotate (Z) or Pan icons. 

 
The Zoom Region Tool will change the NPP. 
 
Because the Zoom Region Tool changes the NPP, perspective projections might become 
imprecise. In that case, use the Pan View tool and the Zoom View tool instead.  
 
Unzoom All Oneshot 
Centers all visible objects in the view, by calculating the best zoom factor. This is useful when 
you want to see every object in a scene. 
 
To Unzoom All: 
• Click the Unzoom All icon  icon or press and release the J key. 
 
This action will move the NPP to the center of the scene. 
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Zoom Selection Oneshot 
Apply a Zoom All action to the selected area of the model (see below for instructions about 
selecting a region of the model). This tool is useful when you want to navigate to a selected 
area in the model. 
 
To Zoom Select: 
• Press and release the Q key. 

 
This action will change completely the NPP. 
 
Double Click and Go 
Double-clicking moves the clicked point to the center of the screen. The NPP will be changed 
to this position too. If the double click was made on a 3D model or Scene Bounding Box, the 
three coordinates of the NPP will be updates otherwise only the two coordinates 
corresponding to the screen XY system will be modified. 
 
Navigation Pivot Point (NPP) 
Usually the NPP is positioned at the center of the screen and does not change after a 
navigation command. The Orbit View Tool uses this point as center of rotation.  The Pan 
View and Zoom View Tools use the NPP to calculate the factor of transformation to apply to 
the action. This factor varies depending on the distance between the Camera and the NPP. 
Small distances cause small offset values. It is possible to modify the NPP as discussed above, 
or by using the Navigation Pivot Point Tool (the Navigation Pivot Point Tool is discussed 
under the Transform Tools section below). 

 
Visualization Tools 
Only meshplots can be hidden. Hidden geometry cannot be selected directly with selection 
tools (Region Selection, etc). 
 
Hide Selection. 
Hides the current selection. This tool is useful when you want to exclude from the rendering 
certain parts of a model without altering the current zone. 

 
To hide a selection: 
• Press and release the H key, or 
• Right-click in the graphics window and choose Display→Hide Selection. 
 
Hidden geometry cannot be selected. 
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Unhide All 
Makes visible all previously hidden geometry. 
 
To unhide all the hidden geometry: 
• Press and release Ctrl+H, or 
• Right-click in the graphics window and choose Display→Unhide All. 
 
Hide invert 
Hides everything that is visible and unhides everything that is hidden. 
 
To unhide all the hidden geometry: 
• Right-click in the graphics window and choose Display→Invert. 
 
Hide Unselected. 
Hides everything that is not selected. 
 
To hide all the unselected geometry:  
• Right-click in the graphics window and choose Display→Hide Unselected. 
 
Display by type 
Changes the visualization of certain types of objects without change the main scene 
composition. Use this option to show or hide quickly all objects of a type. 
 
To show/ hide a type. 
1. Right-click in the graphics window and choose Configuration. 
2. Choose the Viewport tab. 
3. In the Display box, check/uncheck the desired category. 
 
Types of objects for which the visualization can be changed are 
 
• Solid, the objects used to draw the elements, geometry, etc. 
• Band Plots 
• Symbols, node symbols, point symbols, etc. 
• Labels, node labels, point labels, etc. 
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Visualization objects 
 
Cutting Plane 
To temporarily slice away a portion of the model. Sliced objects will be not affected by 
selection tools. 
 
To create a cutting plane: 
1. Activate the cutting plane tool by pressing and releasing the T key or click on the Cutting 

Plane icon . 
2. Move the mouse over the model or Scene Bounding Box to select the initial plane position 

and orientation. 
3. Left click to create the plane. 
4. Manipulate the plane using the transformation manipulator (see below). 
5. Press + key to add a new plane, repeat step 2. You can define up to four planes. 
6. Press the Esc key to finish the tool. 
 
The created cutting planes will be active until they are disabled. The sliced surface will be 
represented in one of the planes colors (yellow, red, green, blue). It is possible to not render 
the sliced surface, by disabling the Cap Sections option (see below) 
 
To remove the cutting planes: 
• Click on the Cutting Plane icon  or press and release the T key.  
 
The cutting planes will be removed automatically when returning to the standard mode.  
 
Reverse cutting direction 
The direction of a cutting plane can be reversed by right clicking on the plane. 
 
Cutting Volume 
The Cutting Volume tool lets you temporarily exclude from the scene a portion of a model 
that lies inside or outside of a volume shape. Objects affected by the volume will be not 
selected by selection tools. 
 
The type of created cutting volumes available are.  
• Box ( ). 
• Sphere ( ). 
• Cylinder ( ). 
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To create a cutting volume: 
1. Click on the Cutting Box, Cutting Sphere or Cutting Cylinder icon. 
2. Manipulate the volume using the transformation manipulator (see below). 
3. Press the Esc key to finish the tool. 
 
The created cutting volume is active until it is disabled. The sliced surface is represented in 
yellow. It is possible to not render the sliced surfaces, by disabling the Cap Sections option 
(see below). 
 
To remove a cutting volume: 
• Click on the active cutting volume icon. 
 
The cutting volume will be removed automatically when returning to the standard mode.  
 
Reverse cutting direction. 
The direction of the volume section can be reversed by right clicking while defining the 
volume. In reverse mode, the volume will be painted in red and all the elements outside the 
volume will be affected. 
 
Cap Sections 
The Cap Sections option enables the representation of the sliced surface resulting from the 
Cutting Section visualization tool (Plane or Volume). This visual effect can be useful 
sometimes. By default, Cap Sections are enabled. 
 
To toggle the Cap Sections option: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport Tab. 
3. In the Viewport group, check/uncheck the Cap Section box. 
 
General comments 
 
Shell elements drawn in midsurface depiction are not drawn correctly. 
 
Open or flipped surfaces are not displayed correctly when rendering the cap surface, disable 
this option to minimize the problem. 
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Selection Tools 
 
Locator Action 
 
Query 
The Query icon lets you select objects within the mesh plots, such as elements and nodes. 
Information is displayed about the selection in the Message Window. 
 
Pick. 
In the standard mode, the Pick icon lets you select mesh plots and annotations such as band 
tables. Because the multiple mesh plot option is disabled in FGM, the Pick icon only permits 
the selection of annotations.  
 
Dialog box selection 
Examples are clicking on the P button, or clicking in a cyan column of a dialog box.  
 
Region Selection 
The region selection tools allow you to select one or more objects by defining an outline or 
area.  
 
The type of created region depends on the current region type.  
• Rectangular Region. 
• Circular Region. 
• Lasso Region. 
 
To switch between region types press and release the Tab key. The default region type is a 
rectangular region. The Query icon and Pick icon only work with a rectangular region. 

  
To select using a rectangle: 
1. Activate a region selection tool. 
2. If the rectangular region is not active, use the Tab key to switch between region types until 

the rectangular region is active. The cursor changes to . 
3. Drag in the view, then release the mouse. The first location you click is one corner of the 

rectangle, and where you release the mouse defines the opposite corner. 
 

To cancel the selection, right click before you release the mouse. 
 

Press Esc to terminate the Region Tool. 
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To select using a circle: 
1. Activate a region selection tool. 
2. If the circular region is not active, use the Tab key to switch between region types until the 

circular region is active. The cursor changes to . 
3. Drag in the view, then release the mouse. The first location you click is the center of the 

circle, where you release the mouse defines the circle radius. 
 
To cancel the selection, right click before you release the mouse. 

 
Press Esc to terminate the Region Tool. 
 
To select using a lasso: 
1. Activatate a region selection tool. 
2. If the lasso region is not active, use the Tab key to switch between region types until the 

lasso region is active. The cursor changes to . 
3. Left-click to define the first segment point. 
4. Move the mouse and left-click to define the second segment point. You can repeat steps 3 

to 4 as many times as you want. 
5. Complete the region by left-clicking without moving the mouse. 

 
To cancel the selection, right click before you release the mouse. 
 
Press Esc to terminate the Region Tool. 
 
If you hold down the Shift key while selecting a region, the selected objects are added to the 
current selection. If you hold down the Ctrl key, the selected objects are removed from the 
current selection. 
  
Click the Esc key to terminate the Region Selection tool. 
 
Deep Selection. 
Include those objects that are occluded by other objects, in other words, those objects that 
cannot be seen because they are behind other objects. 
 
To enable/disable deep selection: 
• Right-click in the graphics window and choose Selection→Deep Selection 
 
By default, deep selection is disabled. 
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Manipulators. 
Manipulators transform one or more objects when the mouse is dragged. Manipulators appear 
when one or more visualization objects are created (see above) and a tool to perform 
transformations is active. 
 
Move Manipulator 
The Move Manipulator moves one or more objects when the mouse is dragged. 
 
To use the Move Manipulator: 
1. Choose an axis by positioning the mouse over one of the three axes of the Axes icon. The 

axis turns yellow to indicate that it is active. 
2. Drag the mouse to move the selection along that axis 
 
Choose an axis by first positioning the mouse over any axis of the icon, then dragging the 
mouse to move the selection along that axis. When you position the mouse over any axis, it 
turns yellow to indicate that it’s active. 

 
Rotate Manipulator 
The Rotate Manipulator lets you choose a plane of rotation when rotating a selection with the 
mouse. Choose a plane of rotation by first positioning the mouse over any plane of the icon, 
then dragging the mouse to rotate the selection in that plane. When you position the mouse 
over a plane of rotation, it turns yellow to indicate that it’s active. Rotate Manipulator uses the 
Angle Snap to set the rotation increment. 

 
 
Snap Mode. 
Use Snap Mode to set increments to a given value. 
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Angle Snap Mode. 
Use this mode to set the incremental rotation to be applied to a number of features.  

 
To toggle Angle Snap: 
• Click the Angle Snap icon  . 

 
To change the incremental angle of rotation: 
• Click the down arrow to the right of the Angle Snap Icon. 
• Fill in the dialog box and click OK. 

 
The default rotation snap angle is 10 degrees. 
 
Scaling Snap Mode 
The Scaling Snap Mode controls the percent of increment to be applied to a number of 
features. For example the Scale Manipulator uses Scaling Snap. 
 
To toggle Scaling Snap: 
• Click the Scaling Snap icon . 
 
To change the scaling increment: 
• Click the down arrow to the right of the Scaling Snap icon. 
• Fill in the dialog box and click OK. 

 
Transform Tools. 
 
Navigation Pivot Point Tool. 
FGM uses the Navigation Pivot Point (NPP) as a reference position to calculate a number of 
features related with the view. With the Navigation Pivot Point Tool you can move this NPP. 
 
To move the NPP using this tool: 
1. Activate the tool by pressing the Insert key. 
2. Use the Move Manipulator to move the NPP. 
3. Press the Enter key to apply the change to the view. 
 
It is possible to cancel the current translation by clicking on the right mouse button without 
releasing the left mouse button. 
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To terminate the tool: 
• Press the Esc key, or 
• Activate a different tool. 
 
Note: If you terminate the tool without applying the changes (by pressing Enter), the NPP will 
not be modified. 

 
2D Transform 
FGM introduces a new way of transform annotations, such as the band plot table. Any 
annotation in the graphics window can be moved, rotated, scaled or resized.  

 
To transform a selected annotation: 
1. Select the desired annotation to be transformed using the Pick icon. 
2. Right-click in the graphics window and choose Transform. 
3. Select the desired transform type by positioning the cursor over one of the five action 

zones or press the Alt key to activate Scale transform (see below) 
4. Drag the mouse. 
5. Repeat steps 2 and 3 until the desired result is obtained. 
6. Exit the tool pressing Esc or changing the tool. 
 
After the Transform 2D Tool is activated, the selected region will be displayed. The mouse 
cursor will change accordingly.  
 
The 2D Transform interface is divided into five zones: 
 
a) Inside the rectangle, a drag action will perform a translation, similar to Dynamic Pan. 
b) Outside the rectangle, a drag action will perform a rotation. 
c) On vertical edges, a drag action will resize in the screen X direction. 
d) On horizontal edges, a drag action will resize in the screen Y direction. 
e) On corners, a drag action will resize in both X and Y directions. 
 
It is possible to cancel the current transform by clicking on the Right mouse button without 
release the left mouse button. 
 
The rotation increment can be set by activating the Angle Snap Mode (see above).  The scale 
increment can be set by activating the Scale Snap Mode (see above). 

 
Note: The 2D Transform tool is only available when the Use Classical UI option (see above) 
is disabled. 
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Selection Representation. 
 
FGM represents selected items in different ways depending on the selected item type. 
Normally selected items are represented in the defined selection color and are not occluded by 
other items. 
 
Note: In the standard mode the selected items are called "highlighted". 
 
Selection Silhouette. 
Shows a black silhouette around the current selection. 
 
To toggle the visualization of the Selection Silhouette: 
1. Right-click in the graphics window and choose Configuration. 
2. Check/Uncheck the Selection Silhouette option. 
 
Selection Box. 
Show a box that bounds the current selection. 
 
To toggle the visualization of the Selection Box: 
1. Right-click in the graphics window and choose Configuration. 
2. Check/Uncheck the Selection Box option. 
 
Visual Appearance. 
 
Surface Smooth. 
Smoothing blends the shading at the edges between adjacent faces based on the angle to 
produce the appearance of a smooth surface. The advantage of this technique is that smooth 
surfaces are generated without increasing the surface density (in, for example, the Surface 
Depiction dialog box).  
 
To change the smooth angle: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. Change the Surface Smooth value. 
 
By default the smooth angle is 15 degrees. 
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Smoothing applied with 0,15 and 30 values. 
 

Shader. 
Use Shader to control how shaded surfaces will be represented in a FGM viewport. Each 
shader has properties that define how the shaded surfaces are represented in the view. The 
type of shader used affects the performance. By default all shaded surfaces in FGM use the 
same shader (Gouraud).  
 
To set the current shader: 
1. Right-click in the graphics window and choose Shader. 
2. Choose the desired shader. 

 
Gouraud 
The Gouraud shader calculates the color for each vertex (per-vertex shading) and associates 
the color with that vertex. The colors are then interpolated across the face of the polygon to 
produce a smooth effect. The final quality of the represented surface depends on the face 
density. 
 

 
 
The shader properties used for the lighting are Ambient, Diffuse, Specular and Emissive 
colors. 
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Gouraud-Lambert. 
Like Gouraud, the Gouraud-Lambert shader calculates the lighting calculations per-vertex, but 
the Gourand-Lambert shader does not apply the specular component. The lighting calculation 
for this shader is similar to that used in the standard UI. 
 

 
 

Gouraud-Lambert  is the simplest shader and fastest. 
 
The shader properties used for the lighting are Ambient, Diffuse, and Emissive colors. 
 
Lambert. 
The Lambert shader represents matte surfaces with no specular highlights. The lighting 
calculation is performed per pixel. 
 

 
 

The shader properties used for the lighting are Ambient, Diffuse and Emissive colors. 
 

Flat. 
The Flat shader calculates the lighting on each face independently of its neighbors, so that 
there is no variation of color across the face, causing each polygon to have a flat appearance. 
This can be useful in situations where the shape of the object warrants such a technique, 
perhaps because the faces really are intended to look flat, or to help visualize the locations of 
the polygons in a complex mesh. 
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The material properties used for the lighting are Ambient, Diffuse, Specular and Emissive 
colors. 
 
Blinn. 
Blinn is a shader that is particularly effective at simulating metallic surfaces (for example, 
brass or copper) which typically have soft specular characteristics. 
 

 
 

Phong. 
The Phong shader represents glassy or glossy surfaces with a hard specular highlight. 
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Image Based Lighting (IBL). 
IBL is a shader that uses an environment texture to illuminate the scene. 
 

 
 

Environment. 
This shader is effective in simulating the reflection of the environment in metallic surfaces. 
 

 
 

Wireframe. 
This shader represents the edges of the facets as red lines and the interior in white. 
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Gooch. 
Gooch (cool to warm) shading is a type of non-realistic lighting. 

. 

 
 

Translucency. 
FGM introduces a new way of visualizing the interior of a solid. 

 
 

To toggle translucency: 
• Click the Cull Front Faces icon  
 
To configure the translucency: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. Choose a Method in the Translucency Method field (see below for choices) 
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Average. 
Average is the default render mode for translucent surfaces; it combines good performance 
with adequate quality. 
 

 
 
Fast. 
When the Fast mode is active, the translucent surfaces will be represented as fast as possible 
but ignoring quality. Use this method for complex scenes where performance is required. 
 

 
 
XRay. 
Similar to Average in performance, this method imitates the representation of a X-ray of the 
surface. 
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Dual Peeling. 
Dual peeling is the slowest method of representation. It requires more graphic memory. 
 

 
 

Shadows 
FGM uses the Shadow Maps technique to represent the projected shadow from a point of 
light. By default the resulted shadows are similar to the outside shadows caused by the Sun. 
The quality of the shadows depends on the type of simulation used to calculate the shadow 
maps and the shadow map quality itself.  

 
To toggle the representation of shadow: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport Tab. 
3. In the Effects box, check Shadow. 
 
All the surfaces in the scene tagged as shadowcaster will participate in the calculation of the 
projected shadow and its shadow will be represented over surfaces and the ground plane. If 
the surface caster is tagged as receiver, the produce shadow will be represented over itself. 
Translucent surfaces are tagged as caster. 
 
FGM has two types of shadow-receiver:  
• Solid. 
• Ground Plane.  
 
Depending on the active receiver, shadows will be represented in different ways. 
Note: One receiver should be enabled to see the shadow effect 

 
Solid surfaces in the scene tagged as shadow receiver will be represented with the projected 
shadows on it. By default all the solid surfaces are tagged as receiver. Translucent surfaces are 
not tagged as receiver. When Solid option is active, surfaces affected will be represented with 
a Phong shader. 
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The quality of the shadow maps is directly affected by the size of the texture used for 
representing the shadow. High quality requires more GPU memory. 
 
To change the Shadow Maps quality: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. Choose the desired shadow quality. 

 
When shadow rendering is activated, the chosen method affects the quality of the shadows 
and the performance of the scene. 
 
To change the current method: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. Choose the desired Shadow Type (see below for choices) 
 
Hard Edges Shadow Map. 
The hard edges method produces pixelated and hard edged shadows. This method is the 
fastest in computation time. 
 
Soft Edged Shadow Map (Jitter). 
The Jitter method is similar to the hard edges method but produces smoother edges. This 
method is more expensive in computation time than the hard edges method. 
 
Percentage Closer Filtering (PCF). 
PCF is more expensive in computation time than the previous method but the quality is 
superior. This is the method used by default in FGM. 
 
Variance Shadow Maps (VSM). 
VSM is the most expensive in calculation time and in memory utilization. It creates smooth 
edges without pixelation. 
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Reflections. 
Renders the reflections of solid surfaces on the ground plane. This effect can affect the 
visualization performance. By default and for increased performance, the reflected image is 
not calculated during a camera transformation. 

 
To toggle the representation of reflections: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport Tab. 
3. In the Effects box, check Reflection. 
 
To customize the representation of the reflections: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. In the Reflection box, change the quality and strength values (see below). 
 
Reflection Quality. 
Controls the size of the texture used to represent the reflected surfaces. Higher quality requires 
more GPU memory. The default quality is Medium. 
 
Strength. 
Controls how the reflected texture is blended with the scene. 
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Silhouettes. 
Silhouettes give a better idea of the shape of the model. By default silhouettes are represented 
as black lines on the edge of solid surfaces.  
 

 
Scene with Silhouette option activated. 
 

To toggle the silhouette representation: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Viewport Tab. 
3. In the Effects box, check/uncheck the Silhouette option. 
 
The representation of the silhouettes can affect the performance of the scene especially when 
there are translucent objects. 
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Screen Space Ambient Occlusion (SSAO). 
SSAO is a rendering technique created and used in video games that improves the realism of a 
scene in real time. For improved performance, SSAO is disabled during view transformation 
(see Navigation tools). SSAO works better with a perspective projection. 

 

 
SSAO visualization 
 

To enable the use of SSAO: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. In the SSAO box, choose the Method, Quality, Filter, Strength and Radius (see below for 

details).  
 

SSAO method. 
Depend of the method used to calculate the SSAO, the quality and performance varies. The 
available methods are 
• Fast. 
• Medium. 
• Slow. 
• N/A (no SSAO) 
 
Radius. 
Radius changes the amplitude of the affected zones. 
 
Strength. 
Controls how much black is used in the affected zones. 
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Quality. 
Controls the size of the texture used to apply the effect. High quality requires more graphic 
memory. 
 
Filter. 
After the calculation of the SSAO, a blur filter is applied to the final image to improve the 
realism. The available filters are: 
• Gaussian. 
• Bilateral. 
• Binomial. 
• None (no filter) 

 
Scene rendering 
 
Original and deformed meshes. 
In the standard mode, when both original and deformed meshes are plotted together, the 
original mesh is always displayed behind the deformed mesh.  This makes it impossible to see 
clearly the shape of the original mesh. 
 
In the FGM, the Translucency feature can be used to control the level of transparency of the 
original mesh, see above. Note: while both meshes are displayed, selections can only be made 
in the deformed mesh. 
 

 

 
Original mesh and deformed mesh with band plot. 



 Fast Graphics Mode 
 

 
ADINA System 9.0 Release Notes 49 
          

Geometry and original meshes 
In the standard mode, when the both the geometry and original mesh are plotted together, the 
geometry is always displayed behind the original mesh. This made it impossible to see clearly 
the shape of the geometry. 
 
In the FGM, the Translucency feature can be used to control the level of transparency of the 
geometry, see above. However, selections can only be made on the mesh, not on the 
geometry. 
 

 
Geometry and original mesh 
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Pattern Lines. 
FGM introduces a new type of representation named Pattern Lines. These lines use a texture 
when drawing thick lines. 
 
The types of geometries represented with Pattern Lines are: 
• Contact surfaces. 
• Fluid structure boundaries. 
• Gluemesh surfaces. 
 

 
Representation of contact surfaces using pattern lines 
 

To change the current pattern: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Pattern Lines Tab. 
3. Select the desired pattern to use (see below). 
4. Check the Enabled field for each channel for which the color should be customized. Other 

channels use the base color. 
5. Select a color to apply to each channel using the appropriate color button. 
6. Select the transparency level by changing Alpha value, 0 value to not use this channel at 

all. 
 
 
 
 
 
 



 Fast Graphics Mode 
 

 
ADINA System 9.0 Release Notes 51 
          

Available patterns 
 
0 Standard mode representation. 
1  
2  
3  
4  
5  
6  
7  
8  
 
The colors in the patterns can be changed by changing the colors associated with the channels. 
By default, channel 0 is red, channel 1 is green and channel 2 is blue. 
 
Pattern lines have two quality levels, Volume and Flat, the second one is recommended for 
high performance. A scene refresh (using the Refresh icon) is necessary to apply this change. 
 
Note: During view transformation (see Navigation Tools) pattern lines are represented as Flat 
lines. 
 
Dynamic 3D Labels 
3D Labels are object with a 3D position represented as a text that maintain an orientation and 
size on the screen. Examples of 3D Labels are point labels, node labels, etc.  
 
In the standard mode these objects have two problems: 
 
• They are extremely costly to render.  
• Large numbers of objects obscure the plot. 

 
FGM solves these two problems using Dynamic 3D Labels. Dynamic 3D Labels are grouped 
in node boxes. Each node box is a box that holds a set of labels that are within the node box 
boundary. The size of each node box is calculated based on the distance between labels and 
number of labels per node box. (Do not confuse the concept of node box with the concept of 
node.) 
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To change the current 3D Label visualization: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Dynamic Optimization Tab. 
3. In the 3D Labels box, change the desired values (see below). 
 
Threshold. 
Controls the maximum number of labels that can be inside a node box. A high number of 
labels per node box will increment the node box size and reduce the total number of labels 
displayed. Threshold values can be absolute or percentage. 
 

 
Absolute Threshold values 10, 50, 100. 
 

Distance. 
Controls if a node box is active or not based on the distance to the camera. Node boxes out of 
range are represented by only one label. 
 
Density. 
When a node box is active (within distance range), controls how many labels are displayed. 

 

 
Left Density 0, Distance 0, Right Density 1, Distance 1. 
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Note: set Distance and Density to zero for a standard visualization, in which all labels are 
visualized. 
 
Selected 3D Labels are always visualized. 

 
Dynamic Surface Optimization. 
FGM uses a bounding volume hierarchy (BVH) structure to accelerate the visualization of 
solid surfaces on big models.  This feature is disabled for small models. 
 
To change the current Dynamic Surface optimization: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Dynamic Optimization Tab. 
3. In the Surface box, change the desired values. 
 
Threshold. 
Controls the maximum number of primitives that can be inside a node box. A high number of 
primitives per node box will increase the node box size and reduce the total number of node 
boxes. Threshold values only are applied after the Refresh icon is clicked. 

 
Threshold values can be absolute or percentage. 

 
Check Visibility. 
Each node box checks its visibility on the screen; when a node box is not visible because it is 
out of the screen or behind another node box, it is considered internally hidden.  High values 
increase the visualization performance but can show gaps in the surface. 
 
If zero is entered, no evaluation of visibility is made and the contents of all of the nodes boxes 
are drawn. 
 
Advanced Configuration 
 
Vertical Sync. 
 
Enabling VSync tells the graphics card how to synchronize its actions with the monitor. That 
means the graphics card can swap its frame buffer and send a new frame to the monitor only 
when the monitor is ready to redraw a new screen. This affects the number of Frames Per 
Second (FPS).  
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To change the Vertical Sync: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. In the Visualization box, make a selection (see below). 

 
On 
When VSync is enabled, what happens is that the graphics card is told to wait for the monitor 
to signal when it's ready for a new frame before supplying a single whole frame, each and 
every time. The first noticeable impact is that the FPS becomes capped at a maximum equal to 
the current refresh rate. So if the refresh rate is 60Hz for example, the frame rate can now only 
reach a maximum of 60 FPS.  

 
Off 
When VSync is disabled, the FPS can be greater but the ‘Tearing’ effect might appear. 

 
Auto. 
When Auto is chosen, VSync will only be enabled whenever the FPS exceeds the refresh rate. 
If the FPS falls below the refresh rate at any time, VSync is instantly disabled.  
 
Ground Plane. 
Shadows and Reflection effects are represented onto the ground plane. By default the ground 
plane is transparent and only the received effects are visible on the ground plane. The render 
of the ground plane is very fast and does not affect the performance of the scene. 
 
By default the ground plane is parallel to the XZ plane and it is situated automatically under 
the model.  
 
To change the ground plane orientation: 
1. Right-click in the graphics window and choose Configuration. 
2. Select the Advanced Tab. 
3. In the Visualization box, select the Ground Plane. 
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Available documentation 
 
The following documents are available with the ADINA System.  These documents are 
modified in this release of the ADINA System as described below.  
 
ADINA User Interface Command Reference Manual 

Volume I: ADINA Solids & Structures Model Definition, Report ARD 13-2, 
December 2013 

Volume II: ADINA Heat Transfer Model Definition, Report ARD 13-3, December 
2013 

Volume III: ADINA CFD & FSI Model Definition, Report ARD 13-4, December 2013 
Volume IV: ADINA EM Model Definition, Report ARD 13-5, December 2013 
Volume V: Display Processing, Report ARD 13-6, December 2013 
Updates are made for the new and updated commands.   
 

ADINA Primer, Report ARD 13-7, December 2013 
Problem instructions are revised for the ADINA System 9.0.   
 

Theory and Modeling Guides 
Volume I: ADINA Solids & Structures, Report ARD 13-8, December 2013 
Volume II: ADINA Heat Transfer, Report ARD 13-9, December 2013 
Volume III: ADINA CFD & FSI, Report ARD 13-10, December 2013 
Volume IV: ADINA EM, Report ARD 13-11, December 2013 
The new features of the solution programs are described. 

 
ADINA Verification Manual, Report ARD 13-12, December 2013 
 
Nastran Interface Manual, Report ARD 13-13, December 2013 
 
TRANSOR for FEMAP, Report ARD 13-16, December 2013 
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